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Information in this document is subject to change without notice. 

 

This document is considered confidential and proprietary between INSTRON and its customers.   

 

No part of this document may be reproduced or transmitted in any form or by any means,  

electronic or mechanical, for any purpose, without the express 

 written permission of INSTRON. 
 
 

Microsoft, Microsoft Office, Excel and Windows are registered trademarks of Microsoft. 
Animations in Partner Software use Macromedia Flash Player Software by Macromedia, 
Inc., Copyright 1995-1999 Macromedia, Inc. All rights reserved.  Macromedia, Shockwave, 
and Flash are trademarks or Macromedia, Inc.   
Other product and corporate names may be trademarks or registered trademarks of other 
companies and are used only for explanation and to the owner’s benefit, without intent to 
infringe. 
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WELCOME TO PARTNER 
Partner is a materials testing application that is designed to make creating test instructions 
(known as procedures) and running tests faster and easier by taking advantage of the newest 
computer processors and the advanced Windows® operating system.  Partner comes ready to 
interface with SATEC Series MATS II, APEX, VERTEX, and Instron’s 5500 controllers and 
appropriate load frames. 

You don’t have to be a rocket scientist to create a test procedure.  Partner walks you step-by-
step through the creation of a test procedure.  Our exclusive TestWizards prompt you for the 
appropriate information needed based on your choices.  

And the choices are many to suite your specific application.  Partner comes with hundreds of 
pre-defined calculations and formulas that reflect standards for a variety of industries.  In 
addition, optional calculation packages are available through your Instron sales representative. 

Thanks to the Windows® preemptive operating system, you don’t have to wait around for the 
computer.  You can run a test or edit a procedure while a report is being compiled.  You can 
even run another application, like Microsoft Excel® while editing a procedure.  You’ll get 
greater throughput and productivity instead of waiting on the computer. 

Once your procedure is created and the test run, Partner doesn’t stop.  Partner integrates 
seamlessly with Microsoft Office Professional®.  We use standard data formats that can be used 
by any of the MS Office applications.  You’ll spend less time processing post-test reports by 
automating tasks and sharing information over your network. 
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Installation 
In most cases, Partner was completely pre-installed on your Partner PC by an Instron 
application engineer.  However, if for some reason, you must re-install Partner, use the Partner 
CD-ROM provided with your system.  For installation procedures go to page 36. 

System Requirements 
Before beginning installation of Partner, let’s review the minimum personal computer system 
requirements needed to successfully run the software: 

 
Computer A Pentium 166 MHz or higher personal computer (PC) that will run Microsoft 

Windows ® *. A minimum of 16 megabytes of RAM is required. 

*MS-Windows 2000 and XP are only supported for use on test systems using the 
Mark III, 5500 Controller or a MatsII controller interfaced via a PCI Arcnet 
card. 

Software Windows ® must be installed and operational before installing Partner.  

Note:  MS-Windows 2000 must be installed on the PC by the manufacturer of 
the PC. 

Disk Drive A hard drive with at least 200 megabytes free to install all calculation libraries, 
databases, and help files. It is recommended that 1.6 gigabyte be available for 
adequate test results storage.  

Mouse Any pointing device supported by Windows®. Although the software may be 
operated from the keyboard, it is strongly recommended that a mouse or other 
device be used to optimize convenience. 

CD-ROM drive An 8x CD-ROM reader.  

NOTE: Additional hardware will be necessary to control the Frame and will vary 
depending on the type of controller. 

 

A Setup program automatically installs all the required files to run Partner on to your hard drive 
and configures your system. You must install Partner using the Setup program.  Performing a 
copy of files from the CD to the hard disk will not work.  



 Partner 
Materials Testing Software For Windows® 

 

  3 

Partner Software Support 
If you need more help, our Software Support department will assist you. As a registered 
customer, you’ll receive: 

• 3-year warranty on the Partner PC, including first year on-site service. 

• 1-year software support and warranty. 

For more help: 

• Software Support representatives are available Monday through Friday, 8:00 a.m. to 
5:00 p.m. (Eastern Time) 800-726-8378. 
or 

• FAX at 724-458-9614 
or 

• E-Mail:  support@satec.com 

When you call for assistance, our representative will ask which version of Partner is running on 
your system.  

Determining Partner Version 
1. Start Partner. 

2. Select Help from the menu bar. 

3. Then, select About Partner... 
The version number of the current running software will be displayed. 
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Software License Agreement 
INSTRON SOFTWARE LICENSE AGREEMENT 
This License Agreement describes important rights and obligations governing your use of the 
enclosed computer software and related documentation (the “Software”), which you should 
read carefully. 

LICENSE: You are granted a nonexclusive license to use the Software in your own business, 
only on a single item of computer equipment permitting use by a single user at any given time.  
You are permitted to make a reasonable number of copies of the Software, only for backup or 
archive purposes in connection with use on the same single item of computer equipment. 

LIMITATIONS: You have no right to reproduce the Software except for backup or archive 
purposes as stated above, and no right to distribute the Software or prepare derivative works 
based on it.  You may not use the Software on more than one item of computer equipment or 
permit use by more than one user at one time, including any such use on multiple items of 
equipment associated in a network or similar configuration.  You shall not, by any leasing, 
external time-sharing, service bureau or similar arrangement, permit the use of the Software in 
any business other than your own business. 

PROPRIETARY RIGHTS; CONFIDENTIALITY: The Software and all proprietary rights 
therein, including copyrights and rights under the trade secret laws of any jurisdiction, are the 
property of Instron or the third party owner identified on the Software.  Your rights in the 
Software are limited to those expressly licenses hereby.  Any copies which you make of the 
Software must include all copyright and other proprietary notices included in the original 
without alteration.  You agree not to disclose or otherwise make available the Software to any 
person other than your employees who require such access in connection with the Software, 
and shall establish reasonable security precautions to prevent unauthorized disclosure.  You 
shall not attempt to disassemble, reverse compile, or reverse engineer the Software in any 
manner. 

TRANSFER. You may transfer the Software to another party only if (i) such party agrees to all 
terms of this Agreement; (ii) you notify Instron of the name and address of such party; and (iii) 
you do not retain any copies of the Software.  Any other attempted assignment, sublicense or 
other transfer of the license granted hereby shall be void. 

TERMINATION: The license granted hereby shall terminate upon any failure on your part to 
comply with the terms hereof.  Upon termination, you shall have no further right to use the 
Software and shall immediately return to Instron or destroy all copies of the Software in your 
possession.  Your obligation of confidentiality with respect to the Software shall survive any 
such termination. 
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Warranty 
 

WARRANTY: Software which is proprietary to Instron is warranted for a period of one year 
from the date of shipment to function generally in accordance with its documentation, but such 
functioning is not warranted to be uninterrupted or error-free.  Third party Software is 
warranted for the same period and to the same extent that our licensor has warranted to us.  
EXCEPT AS EXPRESSLY PROVIDED HEREIN, INSTRON MAKES NO WARRANTIES, 
EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, INCLUDING WITHOUT 
LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR USE. LIABILITY: Instron's sole liability, and your exclusive remedy, 
for matters relating to the Software shall be the repair or replacement of any software which 
fails to satisfy the warranty set forth above.  You by acceptance of the Software assume 
liability for any damages which may result from use or misuse of the Software by you or your 
employees, or by others.  EXCEPT AS EXPRESSLY SET FORTH HEREIN, INSTRON 
SHALL HAVE NO LIABILITY, IN CONTRACT, TORT OR OTHERWISE, FOR ANY 
MATTER RELATED TO THE SOFTWARE.  IN PARTICULAR, WITHOUT LIMITATION 
OF THE FOREGOING, INSTRON SHALL HAVE NO LIABILITY FOR ANY INJURY TO 
PERSON OR PROPERTY, LOSS OF PROFITS, OR OTHER INDIRECT, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES. 
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USING PARTNER FOR THE FIRST TIME 
Everyone at Instron has worked hard to make Partner as easy to use as it is powerful. We’ve 
taken advantage of Windows® to make creating procedures, running tests, and reviewing results 
as easy as pointing and clicking a mouse.  

Before proceeding, ensure that... 

• Your load frame and controller have been correctly installed.  Refer to the appropriate 
frame and accessory manuals. 

• The controller is properly connected to the frame. 

• The controller is properly connected to the Partner PC. 

This section is designed to acquaint you with the most common Partner features. 
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Starting Partner 
 

1. With Windows® running, double click the Partner Icon on the Desktop.  
or 

Click the Start button and: 

• Choose Programs 

• Choose Instron-Satec 

• Choose Partner. 

2. In the Partner Login box, type your Partner password; 
then click OK.  If this is the first time you are running 
Partner, use the factory set defaults: 

Name = “Default” 

Password = “Supr” 

You may change the password later. 

3. From this “start up” box, you can immediately perform 
one of four options: 

• Click Existing to run or edit an existing procedure.  

• Click New to create a new procedure with the 
TestWizard. See Creating a New Procedure on 
page 23; 

• Click Results to open stored results from a 
previously run test. See To view test results on page 
32; 

• Click Other to perform another Partner task. 

If this is the first time you are running Partner or your system was not configured at the factory, 
click Other.  Partner must be told about the load frame, controller and any accessories that are 
being used before a test can be run.  To configure the frame, see the [Tools – Configuration 
Panel] section of the Help System. 
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A View of the Desktop 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

One of the greatest advantages of Partner is that it retains the look and feel of other Windows® 
applications.  Things that you learned about using Windows® and Microsoft Office applications 
also apply when using Partner. 

 

Desktop: 

System-Menu Box As in other Windows® applications, the System-menu box allows you to 
restore, move, size, minimize, maximize or close the Partner window. 

Menu Bar The menu bar lists the highest level of commands available in Partner. For 
more information on Partner commands see Commands Available Through 
the Menu Bar, page 9. 

Tool Bar The tool bar displays common Partner commands that can be quickly 
accessed with a click of the mouse. For more information on these 
commands, see Commands Available Through the Tool Bar, page 15. 

Procedure and Results This area of the desktop displays panels that allow you to build and edit 
procedures, run tests, and review results. 

Status Bar This area of the desktop gives you information concerning areas of the 
screen or any actions being undertaken by Partner.  For example, if the 
mouse cursor rests over a button in the tool bar, text in the status bar will 
give you information about the button’s function. 

Tool Bar 

Procedures and Results 

System Menu Box 

Menu Bar 

Status Bar 
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Commands Available Through the Menu Bar 
Note: For more information on any of the following menu items, please consult either Partner’s 
Operating Help system and look under the Partner Menus section or Partner’s Reference Help 
system and look under the Navigation section. 

 

File Menu: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
New Procedure CTRL+N Create a new procedure.  

Open Procedure CTRL+O Open an existing procedure. 

Close Procedure  Close the current procedure. If the procedure has been changed, 
Partner will prompt you to save the procedure first. 

Save Procedure CTRL+S Store procedure information to the hard disk. 

Save Procedure As..  Allows you to store the procedure with a new name: usually used to 
copy a procedure. 

Open Result  Open an existing set of test results. 

Open Next Result CTRL+R Open the next result in the current results database. 

Open Prev. Result Shift 
CTRL+R 

Open the previous result in the current results database. 

Close Result  Close current set of test results. 

Save Result  Save the current test into the results database (.mdb) you have 
assigned. 

Create New Results 
Database 

 Add a new database to the system. Test results can be stored in this 
database. 

Change Results 
Database 

 Select in which database test results are stored. 

Export   Export results and/or data points to a text file or database. 

Mail  E-mail test results or data points. 
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Copy Graph to 
Clipboard 

 Copy the graph to the Windows® clipboard as a bitmap. 

Print CTRL+P Print current graph and test results. 

Print Graph  Print current graph. 

Print Wizard Pages  Displays the wizard, performs a screen capture and sends the image 
to the printer. 

Print Setup  Display Windows’ printer setup dialog box. 

Recent File  List of four most recently accessed procedures.   

Exit  Exit Partner. 
 

Parameters Menu: 

 
 
 
 
 
 
 
 
 
 
 
 
 
TestWizard CTRL+W Start the TestWizard.  The TestWizard allows you to create a 

default test or walks you though a series of steps to customize data 
entry.  The TestWizard also allows you to quickly change the most 
important procedure parameters of an existing procedure.  

Run Time  Display the Run Time Parameters window and enter the 
appropriate information. 

Calculations  Open the Calculations definition dialog box.  This allows you to 
add, modify and delete the types of calculations performed during 
the current procedure. 

Data Acquisition  Change how much data is being collected and stored by Partner. 

Database  Prompt you to use the current database or Specify a unique 
database for this procedure. 

Interactive Graphics  If you have selected a calculation that supports interactive graphics 
and the option is turned on for that calculation, you may manually 
select points of interest for the calculation using the mouse. 

Measurements  This allows you to add, modify and delete the types of 
measurements taken during the current procedure. 

Safety Limits  The system places you into the Safety Limits dialog box and will 
display any existing Safety Limits and their corresponding 
Measurement and High/Low Limit values. 

Soft Keys  Allows you to define the behavior of the keys labeled “1” and “2”" 
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of the user panel for systems using the Instron 5500 controller. 

Specimen  This allows you to change or modify the specimen for the current 
procedure. 

Test Control  This section starts with the Zero Measurements page, proceeds 
through Soft Start and then moves to the Machine Control Setup. 

Test Tags  This allows you to add, modify, and delete test tags. It also allows 
you to specify when they appear to the operator: before or after the 
test. 

Text Displays  Allows users to change fonts, colors, and font sizes for the text 
panels on Partner's main display screen. 

Text Results Format  This option may be used to create plain text reports from individual 
tests. 

XY Graph  Allows you change many graph properties: label colors and fonts; 
grid styles and colors; line widths; divisions, etc. 

 

View Menu: 
 
 
 
 
Toolbar Toggles the Partner toolbar. 

Status Bar Toggles the Partner status bar. 

During Test Entry Enables the user to enter specimen parameters and test tags for future test 
specimens while the current test is in progress. 

 

Test Menu: 

 
 
 
 
 
Next Specimen F9 Run the current test again, using a new specimen. 

Run F11 With a procedure open, starts the test. 

Custom Interface F3 Calls a user defined function to open a procedure. 

Pause F5 With a test in process, stops the test on command. When test has been 
commanded to pause, this resumes the test. 

End F4 This command stops a test at the operator’s discretion. All data gathered 
up to the end point will be stored in the results database. Any pre-defined 
end of test actions will occur. This command is usually used before the 
specimen breaks, but after the necessary data has been gathered. 

Abort F8 This command stops a test at the operator’s discretion. All data gathered 
up to the end point will NOT be stored in the results database. Any pre-
defined end of test actions will occur. This command is usually used if 
something in the set up of the test is unsatisfactory and you wish to start 
over. 
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Machine Menu: 

 
 
 
 
 
Disable Frame F12 This command immediately stops movement of the frame and disables the 

pumping unit or drive system. 

Manual Adjust   This command allows you to set the manual adjust speed of the frame. 

On-line  This command either establishes or disconnects communications between 
the frame and the Partner PC. 

Enable Frame  5500 controller only.  This command allows the frame power to be turned 
on. 

Go to Zone  This selection appears when you are online with any type of procedure.  
Before and after a test it will only let you select the standby zones - 
typically "Manual Control" and "Return To Start". During a test, "Manual 
Control" and "Return To Start" will be grayed out, and the user will be 
able to select any of the test zones. 
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Transducer Menu: 

 
 
 
 
 
Zero a 
Measurement 

This command allows you to individually zero one or more measurements.  

Zero All 
Measurements 

This command automatically zeros all measurements. 

Reset a 
Measurement 

This command allows you to reset one or more measurements. 

Set Measurement 
To 

This option allows you to set the current value of a measurement to a specified 
value.  It is similar to the Zero a Measurement option but is more general in that 
you can set the measurement to any value -- not just zero. 

Note that Set Measurement To does not move the frame. 

Calibrate When Calibrate is selected a fly-out menu will appear displaying all transducers 
capable of auto and manual calibration that are selected for the current 
procedure. 

Cal Check Automatic calibrating transducers are equipped with a shunt relay that enables 
you to perform a calibration check. Performing this check will let you know if 
the transducer is out of calibration and needs to be calibrated.  

 

Tools Menu: 

 
 
 
 
 
 
 
 
Change Password Allows the user to change the current users password.  This requires input of the 

old password to verify a password change. 

Login as Different 
User 

Allows user to login as a different user without exiting Partner.  

Access Report 
Generator 

Upon making this selection a data entry form entitled Access Report Generator – 
linked to results.mdb will appear.  Partner's Reporting Tools are designed to 
assist you in creating reports and working with results.  Note: For use with 
Microsoft® Office 97 Professional or later. 

Excel Report 
Generator 

The Excel Report Generator allows for easy creation of reports in the form of 
Microsoft Excel workbooks.  Note: For use with Microsoft® Office 97 
Professional or later. 

Results Manager Use the Results Manager to move, copy, and delete test results. 
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Configuration 
Profile Backup 

Backup configuration settings to a floppy disk. 

Configuration 
Profile Restore 

Restore configuration settings from a floppy disk. 

Configure Displays the Configuration Menu. This allows you to change system parameters 
from load frame and controller configuration to  Partner resolution. 

Chart Generator The Chart Generator is an optional component. 

Quick Access to 
Files 

Gives user quick access to additional files, reports, macros and programs stored 
in the ...Partner\Tools folder or in a specific folder that the user selects.  

 

Units Menu: 

 
 
 
 
 
As Defined by the 
Procedure 

All units in the procedure are displayed in units as defined by individual 
parameters. 

All US Customary All units in the procedure are displayed in customary US units. 

All Metric All units in the procedure are displayed in metric units. 

All SI All units in the procedure are displayed in system international units. 
 

Help Menu: 

 
 
 
 
 
Partner Operating 
Help 

Opens the Partner Operating Help that contains brief information on the most 
commonly used features of Partner.  It is available in all languages supported by 
Partner. 

Partner Reference 
Help 

Opens the Reference Help System, which contains more in-depth information.  It 
is available only in English. 

Partner On-Line 
Resources 

Access helpful tips about using Partner from the internet. 

Instron Home Page Connects you to Instron’s web site (www.instron.com) 

About Partner  Displays the current version of Partner. 
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Commands Available Through the Tool Bar 
The tool bar provides you with some of the most common commands that you will need when 
using Partner.  The following illustration shows the tool bar and a short description of each 
button’s function.  These functions are also available through Partner’s menu bar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Zero One Channel 

Zero All Channels 

On and Off Line 

Display Online Help 

Go To Zone 

Return To Start 

Machine Hold 

Release Automatic Extensometer 

Disable Frame 

End Test 

Pause Test 

Start Test 

Run Current Test on New Specimen 

Run Time Parameters 
Run Test Wizard 

Print Test Results 

Save Results 
Open Results 

Save Procedure 
Open a Procedure 

Create a New Procedure 
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ON-LINE HELP 
Partner offers two types of on-line Help. They include Operating Help and Reference Help 
and both can be accessed from the Help menu of Partner.  

• Operating Help contains instructions on how to use the most common features and 
functions of Partner. It is displayed in the language currently selected for Partner and 
makes use of an HTML Help format. 

• Reference Help contains very detailed information regarding all aspects of the testing 
system and includes diagrams, animations and screen captures. It is also HTML-based, but 
uses Internet Explorer as its browser. Reference Help is available in English only. 

The majority of this section will focus on the Reference Help System. 

Partner’s Reference Help System is HTML based and supports pictures, sound and animation.  
This means that using Help is like taking an adventure on the World Wide Web.  The Help 
System is designed to act as your on-line reference manual.  Therefore, any time you should 
need assistance operating the Partner software, creating reports, or even understanding 
terminology of Materials Testing, the Reference Help System is a mouse click away.  

Opening Help 

Operating Help 
There are several methods of opening the Operating Help System: 

1. Select [Help – Partner Operating Help] from the menu bar in Partner.   

2. Select the  symbol from the tool bar in Partner 

3. Click the Partner Operating Help Shortcut Icon on your Desktop. PartnerOperatingHelp.chm  

Reference Help 
There are several methods of opening the Reference Help System: 

1. Select [Help – Partner Reference Help] from the menu bar in Partner.   

2. Click the Partner Help Shortcut Icon on your Desktop.   

3. Press F1 from any Dialog Box. 
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Using Internet Explorer (IE) 
Partner’s Reference Help System uses Internet Explorer 5.5 to display its content. Internet 
Explorer 5.5 is a Browser that enables the user to view HTML pages.  When you open the 
Reference Help System, you will see the words “Microsoft Internet Explorer” and its icon at 
the top of your screen.  We supply Internet Explorer 5.5 with Partner Software and expect that 
it is the Browser you will be using when viewing the Help System.  Users that are familiar with 
using the Internet may have other Browsers installed such as Netscape Communicator, Internet 
Explorer 3.0, Opera, etc.  CAUTION: When using other Browsers, the formatting of the help 
pages may appear different, and some of the functionality (search engine and site map 
expandable tree) may be lost.  We do not recommend or support the use of other Browsers.   

Links 
Definition: Links appear as either colored underlined words or images.  When your mouse 
moves over a link it will change shape.  (For standard windows settings your pointer will 
change from an arrow to a hand.)  Links allow you to jump from one page to another or to a 
different place on the same page. 

Using Links: If you left mouse click once on a link you will open a new page or be 
transferred to a different location within the same page that explains the linked text 
or picture in more detail.   To return to the original page simply click the back arrow 
on Internet Explorer’s toolbar. 
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Movies 
While navigating thorough the Reference Help System, you may find embedded movies.  These 
movies are actually animated screen captures that will show the user how to navigate through 
his/her software.   At the bottom of the movie will be a control panel (pictured below.) 

 

 To begin a movie click the play button 

 To Stop a Movie click the stop button 

 To Pause a movie click the pause button 

 

Animations 
Partner’s Reference Help System comes complete with animations. These animations enable 
the trainer to be at your fingertips. 

When viewing an animation click the buttons within the movie 
to move forward or backward through the frames.  Right mouse 
clicking on an animation, will display the menu pictured at 
right.  This menu includes additional options that may be useful 
for zooming in on a graph, rewinding a movie, etc.  

Note: These animations have been created with Macromedia 
Software and require the Shockwave Flash plug-in to be 
installed.   This plug-in is shipped and installed with the Partner 
Software. 
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Navigating through the Reference Help System 
Opening the Reference Help System with any of the four methods listed above will call up the 
“front screen” (pictured below.) 

 

The Left Frame 
This frame is stationary and contains eight images that represent the main sections of the 
Reference Help System.  Clicking on any of these images will take you to the chosen section.  
They include: 

 Getting Started - Includes pertinent information for first time users including: 
 First time tutorial 
 Help System explanation 
 Software Support information 
 What’s New list 
 Back-Up Utility information 

 Terminology - Includes explanations of many hardware, software, scientific, and 
mathematical terms. 
 Frequently Asked Questions - Includes a list of frequently asked questions and their 

solutions. 
 Calculations - Includes algorithms, animations, and setup information for calculations 

that ship with Partner 
 Navigation - Includes detailed information about all menu items and navigation 

techniques for Partner 
 Procedure Templates - Includes an explanation of all procedure templates that ship 

with Partner, as well as a detailed GenTest tutorial 
 Configuration - Includes information for: items under the configure menu, controllers, 

PID gains, Auto Release Extensometers, and Digital Calipers & Micrometers.  
 Reports & Results - Includes an explanation of the Data Manger, the Structure of the 

Database, and information on working with Reports, Queries, & Records 
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The Right Frame  
This frame will change depending on the link you choose to follow. 

When the Reference Help System is first opened this frame will display an animation 
concluding with a series of buttons that will link the user to frequently referenced sections of 
the Reference Help System (Shown Above.) 

 Search - Allows you to search the Help System 
 What's New - Displays a list of what's new by version 
 Software Support - Provides the user with information about Software Support 
 Beginner's Tutorial - Provides an explanation of how to use Partner for new users 
 Using the Help System - Provides the user with an explanation on how to navigate 

through the Reference Help System 
 Site Map - Shows the user all files contained in the Reference Help System in an 

expandable tree structure. 

Note: If at any time you wish to return to the front screen of the Reference Help 
System click on the Instron logo (pictured at left) located at the top left corner of 
your screen. 
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Tabs, Tables, and Page Navigation 

1. First Level of Navigation 

2. Second Level of Navigation 

After selecting an image link from the left hand frame (1st Level of Navigation) or by selecting 
a button provided from the front screen you will open a typical information page of the 
Reference Help System.  The header bar at the top of this page provides the second level of 
navigation.  

 

The Header Bar includes: 

 A Section Label - The Black and Red bar will tell the user which of the eight main 
sections of the Reference Help System the file is contained in. (Above: the controller 
page is contained within the Terminology Section.) 
 A Search Link - Clicking on the magnifying glass in the upper right corner will open 

the search engine of the Reference Help System and allows the user to search for other 
pages by typing in key words. 
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 Red Tabs - These tabs provide the second level of navigation; a way to move to the 
subsections. 
 They will show all subsections contained within the main section. (Above: the 

terminology section contains four subsections: Hardware, Mathematical, Scientific, 
and Software.) 

 The tab that is displayed bright red is the subsection you are currently in (Above: 
the description of the controller is located under the Terminology-Hardware 
section) 

 To go to any of the other subsections, simply click on the desired tab (Above: If the 
user clicked on the Software tab s/he would be linked to the Software subsection.) 

3. Third Level of Navigation 

The third and final level of navigation is the yellow table displayed at the left of the page.  If a 
page does not include a yellow table, it is the only page within that subsection.  This table will 
display all files stored within the subsection.  The file that is currently displayed will be shown 
in red with an arrow to the left.   To open another page within the same subsection, left mouse 
click once on its title.  (Below: If the user wished to open the 'Test Space' page from within the 
same subsection as the ‘Controller’ page,  s/he could left mouse click once on the word ‘Test 
Space.’)  

Searching the Reference Help System 
The Reference Help System includes a search engine so that you may 
quickly locate the answers to your help questions.  In order to open the 
search engine, simply click on the search icon located at the top right corner 
of any page.  Once the search engine has been opened, you may simply type 
in the key word or words you wish to search for. 

Note: If the search returns too many files, simply type in more specific search terms and select 
the search for “all words” option. 
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WORKING WITH PROCEDURES 

Creating a New Procedure 
You may create procedures when a frame controller is not connected to the Partner PC.  
However, you cannot test the functionality of the procedure until a controller is connected to 
the PC.  Refer to your load frame instruction manual for the proper connections. 

1. From the File menu, choose New Procedure.   Partner will present you with a list of 
templates. 

Note:  A template is used to assist when creating a new procedure by providing default values. 
If you do not see a template that suites your needs, choose one that is close.  These 
templates are set up with default parameters that can be changed to your specifications. 

 

2. Highlight a template from which to create a procedure and click OK. 
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Running the TestWizard 
TestWizards are a series of dialog boxes.  Each dialog box asks a question or questions to 
which you should respond.  Each question has a default answer; so if you are missing a piece of 
information you may leave the default answer and change it later. 

 

1. All TestWizard dialog boxes have four common control buttons: 
Back Click to return to the previous step. 

Next Click to continue to the next step. 

Accelerator 
Buttons 

Allow you to navigate backward and forward through the main sections of the Test 
Wizard.  The main sections include: Specimen Type, Test Tags, Measurements, 
Calculations, Soft Start, Test Control, and XY Graph. 

Cancel Click to disregard any changes made to the procedure up to this point. 

Finish Click to quit the TestWizard. Any selections made up to this point will be 
incorporated into the procedure. Selections for following steps will use default 
parameters. 

2. For each step, make the appropriate selections or enter the appropriate information as 
requested by the TestWizard. 

Note:  On-line help is available for each page in TestWizard.  To access, press F1. 

3. When you reach the final step presented by the TestWizard and you are satisfied with the 
procedure, click Finish.  

4. The TestWizard creates a test that is ready to 
run and the Run Time Parameters screen will 
appear. 

 
Note:  At this point it is recommended that you save 
your procedure. 
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Saving A Procedure 
After you create/edit a procedure, you can save the changes.  You can either save the changes 
using the same name that you opened the procedure by or you can save the changes using a 
different name.  When you use a different name, the original file is unchanged, and a new file 
with the new name will be created. 

Partner accepts long file names that allow you to label files with clear and accurate 
identification.  This simplifies searches and takes the guesswork out of retrieving your stored 
procedures. 

To Save a Procedure 
1. Pull down the File menu and click Save. 

To Save as a New File 
1. Pull down the File menu and click Save As. The Save As dialog box will appear with the 

Save In default as Partner. 

2. Complete the standard Windows® Save As dialog box. 

Note:  All procedure files end with a  .PRC extension. This extension is automatically added to 
your filename by Partner when it performs the Save or Save As command. 
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Using an Existing Procedure 
In general, someone at your facility is responsible for creating a procedure and usually someone 
else is responsible for running the resulting test on various specimens.  The procedure can be 
created off line or away from the test frame and controller.  However, if you want to 
experiment with the test before issuing it as a standard test, you do need to have the appropriate 
frame and controller on line (connected and communicating) with the Partner PC.  

Opening an existing procedure 
1. From the File menu, choose Open Procedure.  The Open dialog box appears. 

 
 
2. Use the Look In box to select the drive and directory containing the procedure file you 

want. 

3. In the File Name box, select the file you want to open. 

4. Choose Open. 

Note: You can open only one procedure file at a time. 

5. Once a procedure is open you may modify it by rerunning the TestWizard (see “Running 
the TestWizard”, page 24) or by selecting Parameters from the menu bar of Partner.  
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PERFORMING TESTS 
 

WARNING:  Keep all body parts clear of the testing space while the machine is in 
use.  Make certain the machine has completed cycling, before 
inserting or removing a specimen.  Turn all power off before 
attempting to disassemble, inspect, or clean the system. 

  
  

Eye protection should be worn when operating this machine. 
 
 
 

Starting a Test 
After you have selected a procedure (new or existing) and changed parameters (if necessary), 
you will be prompted with the Run Time Parameters screen. 

 

1. Enter a value for each requested parameter. 

2. Check to see if any errors are listed.  These errors must be corrected before running a test. 

3. After correcting the errors, update the list by clicking Check Errors. 

4. When you are ready to start the test, click Run Test. 
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During a Test 
During the test, the results are displayed dynamically in five panels: graph, rates, peaks status, 
and live.  The graph updates throughout the course of the test based on the selected 
measurements.  The remaining four panels show information on a real-time basis. 

 

The status panel shows information concerning the controller and load frame. The live panel 
shows information concerning the selected measurements. 

Note:  While a test is running, you may use the End Test, Pause Test, Emergency Stop and 
Abort Test buttons. 
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Test Complete 
A completed test looks like this when the Partner PC is on line. 

 

When a test is complete, the information is displayed in five panels: graph, test results, test 
summary, status and live.  The status and live panels are only displayed when the 
controller/frame is on-line with the Partner PC.  

Only one set of test results is created for any one tested specimen.  You may change test 
parameters, but the changes are recorded as part of the original test results. 

Test parameters may be modified by using the commands listed under Parameters in the menu.  
Partner will make the necessary calculations, such as plotting the graph with different graph 
parameters. 

You may print these results to the Windows printer. 

If Interactive Graphics is enabled for a calculation the following screen will appear after test is 
complete: 
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Interactive Graphics 
The Interactive Graphics Panel displays the test plot and lists any calculations that have been 
setup to support interactive graphics. 

Highlight point of interest.

Drag scroll bar thumb to
move crosshairs

Crosshairs

Boundary point

 
1. In the list, highlight the point you want to set. 

2. Cross hairs on the graph show the location of the point. To move the point along the plotted 
line, move the bar thumb to the left or right. 

3. Repeat the process for all other points. 

4. Click OK. 

Partner will compute the calculations with the new boundaries. 
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WORKING WITH RESULTS 
Partner provides many ways to view and report test results and data.  These options allow for 
easy printing of professional reports as well as creation of custom reports. 

Partner’s primary reporting tools are the Access Report Generator and the Excel Report 
Generator.  Both tools allow for easy creation of reports containing both text and graphs. 

Saving Test Results 
All results are saved to an Access database.  The database records the procedure and test results 
together.  Partner assigns a unique identifier to each set of test results.  This unique identifier is 
made up of: date, time, and a test key that you selected in the TestWizard.  When setting up 
your procedure, be sure to designate one of the test tags as the test key in the Test Tags step. 

By default, Partner automatically stores results to a database.  For more details, see the 
[Navigation-Tools-Configure-Storage] section of the Help Files. 

Working with Stored Results  
Partner stores test data so that you may recall the results at any time.  The graph, test summary 
and test results panels are displayed, just as when working with current results, some test 
parameters may be changed.  

 
Stored results opened for review 

Each test is identified by a unique number assigned by Partner, the time, the date of the test, 
and any test tags that are required by the procedure.  If you choose to edit the test using any of 
the Parameter commands, the test results will be recalculated based on the new parameters.  
When you save the test results, they are automatically saved under their previous assigned 
identification.  A new test result is created each time a test is conducted.  

Note:  You can’t change measurement parameters or run the Wizard with a result.  It will 
require the results to be closed. 
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To Save Test Results 
1. Pull down the File menu and click Save Result. 

2.  Partner automatically saves the results to the database. 

Note:  If you make changes to a result that require the test to be recalculated and then save 
those changes, the current test results are updated. A new result record is NOT created. A new 
record is only created when a new test is run. 

To View Test Results 
1. Pull down the File menu and click Open Result. 

 

2. Select the test results you wish to view from the Results dialog box.  Three panels – graph, 
Test Results and Test Summary -- are displayed.  

3. With results displayed: 

• you may run the test again;  

• you may change test parameters and run the changed test; 

• you may change the test parameters and save the changes. 

To Create Reports with Results 
The results of tests performed with Partner are stored in Microsoft Access.  This allows you to 
take advantage of the features of Microsoft Office.  The Report Wizard in Microsoft Access is 
the quickest and easiest way to create professional reports. 

For more information on the structure of the database created by Partner, the Report Wizard or 
the Partner Data Manager please consult the Reference Help System [Reports and Results 
section.] 
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Using a Different Results Database 
All Partner test results are stored in an Access database.  There may be several databases 
available in which to store the results.  Therefore, you may select which database you wish to 
store results.  

Partner automatically assigns a unique number to each test and uses the time and date as well as 
any test tags that you have defined to easily identify specific test results.  

You may create new databases.  You may view the information in those databases by selecting 
the records from the displayed list. 

Partner databases end with the .mdb extension. 

To Select a Results Database 
1. Pull down the File menu and click Change Result Database. 

2. The common Windows® Open dialog box opens. 

3. Select the database you wish to open.  

4. Once the database is selected, pull down the File menu and click Open Results to select test 
results to be viewed. 

To Add a Results Database 
1. Pull down the File menu and click Create New Result Database. 

2. The common Windows® Save As dialog box opens. 

3. A default name appears in the File name data entry field.  Use that name or type your own 
database name. 

4. Click Save. 

Note:  The Access database may reside on any valid disk drive or accessible network drive. 

Exporting Data Points as a File 
The measurement data that is collected during a test is known as data points. Data points can be 
saved in a text file. This gives you the ability to easily insert the data into a spreadsheet, your 
own database or a document.  To export data: 

1. Pull down the File menu and click Export Data Points as Text. 

2. The Save As dialog box opens.  Partner automatically assigns a filename. If you wish, you 
may overwrite this name. 

The file is an ASCII text file that is delimited by commas. 

Note:   Partner has the ability to automatically export the data to a text file after each test.  
This can be configured in the configuration panel. 
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Printing Test Results 
When a test is complete or if you open previous test results, you may print the results.  The 
printout shows the results graph, test summary information and test results.  The results are 
printed to the Windows® default printer.  To print test results: 

1. Pull down the File menu and click Print. 

2.  Partner sends the information to your printer. 

3. When the information is transferred to the printer, the results panels return to the screen. 
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QUITTING PARTNER 
If you have a procedure running or a result file open when you issue the Exit command, Partner 
will ensure that you want to quit.  If you indicate that you do not wish to exit, the current 
procedure or test continues. 

If you do want to quit, Partner saves the current procedure or test results, then closes the 
application. 

To quit Partner: 

• From the File menu, choose Exit. 
-or- 

• Double-click the System-menu box. 
-or- 

• Press ALT+F4. 
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INSTALLING PARTNER 
Before you begin: 

a. What Operating System is installed on your PC?  (Windows 95, 98, 2000 or XP).  
See note below 

 

b. Back up your existing Partner procedures and configuration settings.  Should you 
ever need to restore the existing version of Partner, completing these steps will enable 
you to do so.  To back up your procedures, simply copy your procedure files (ending in 
*.prc) to a disk, zip drive, or archive on another computer.  (Typically your procedures 
are stored in the Partner/procedures folder.)  To back up your existing configuration 
settings: insert a disk into your floppy drive, open Partner, and run the Partner 
Configuration Profile Backup utility by going to the menu bar and selecting Tools-
Partner Configuration Profile Backup.   

Note: MS-Windows 2000 and XP Professional are only supported for use on test systems using 
the Mark III, 5500 Controller or MatsII controller via a PCI Arcnet Card.  Windows 2000 
Professional MUST be installed on the PC by the manufacturer of the PC.  

To install partner: 

1. Insert the CD into the CD drive.  The Partner Installation Startup page will start 
automatically after a few seconds.  Proceed to Step 2. 

 
If the Installation Startup page does not begin when the CD is inserted, it must be 
started manually.  To start the Installation Startup Page manually, do the following: 

a. From the Start Menu, click Run, then Browse. 

b. Expand the Look in box by clicking on the down arrow  

c. Double click on the drive labeled Partner.  

d. Double click on “InstallPage” file in the root folder of the CD. 

e. The path and filename of the Installation Startup page will appear in the Open edit field 
of the Run dialog box.  Select OK.  

f. Proceed to Step 2.  
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2. Begin the Installation by installing each component in the order they appear on the 
page and following all the prompts, accepting their default values. 

Note: The Digilink component is for use with the Instron 5500 controller.  If you have an 
APEX, Vertex, MATS II or Mark III controller, you do not need to install the Digilink 
component. 

3. For Instron 5500 controllers only, click on Digilink to begin installation of this 
component.  Follow prompts and accept default settings. 

4. If your system already has Internet Explorer 5.5 (IE 5.5) or later Proceed to Step 5.  If 
your system DOES NOT have Internet Explorer, you will need to install Internet 
Explorer 5.5 (IE 5.5) from the Partner CD.  

5. Click Exit to end the installation. 

6. Once all components are installed successfully, restart the system. 

a. If upgrading a MatsII – Partner PC, refer to the “PCI Arcnet Installation 
Instructions” for board and driver installation procedure. 

b. If installing Partner on a “New” PC because of a PC upgrade to an existing 
Partner system, refer to the “Partner PC Upgrade Instructions”. 

7. Run Partner by double clicking the Partner icon on your desktop.  At the Partner 
Login Screen type “Default” then “Supr”. 
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If the Installation Startup page does not begin after the CD is inserted: 

If you do not have Partner or have an older version of Partner on your computer and the 
Installation Startup page does not begin when the CD is inserted, the problem is most likely an 
older version of the file “Oleaut32.dll” in your computer’s Windows\System directory.  Instron 
has provided on the Partner CD an updated version of this file.  Simply copy this file from the 
System Dll subdirectory of the CD to your computer’s Windows\System directory.  If you 
cannot see this file on the CD, go to Options in the View Menu of Windows Explorer and make 
sure “Show All Files” is selected.  Then, following the same instructions provided in the 
paragraph above, you can start the Partner Installation startup page and begin the installation of 
Partner. 

After installation, store the Partner CD in a safe place. 

To ensure the best possible support and timely upgrades be sure to register your new copy of 
Partner.  To register, call the Instron Software Support Hotline at 800-726-8378. 

Various annual and multi-year support contracts are available. Call your Instron Sales 
Representative for more information on these flexible options. 
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